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Introduction to the Fabric Agent 
Sun StorageTek Business Analytics provides one unified fabric agent supporting different 
vendor products and interfaces. 

Note: With the acquisition of StorageTek, Sun Microsystems has re-branded and re-
named Global Storage Manager (GSM) as Sun StorageTek Analytics, a member of the 
Enterprise Storage Manager portfolio of software solutions. The functionality of Business 
Analytics is identical to GSM, only the name has changed. 

The products and product interfaces include Brocade as well as the FA-MIB (Fibre 
Alliance MIB) support for switches and Service Processors that support the FA-MIB (e.g., 
McData). SWAPI adds zoning and performance support for McData switches. The CIM 
product interface is used for switches or proxy servers that support the CIM interface. 
Refer to the Sun StorageTek Business Analytics Support Matrix located on the 
Documentation CD for the latest information on supported SANs/fabric switches as well 
as their support requirements.  

The Fabric Agent reports information about the fabric member switches, hardware and 
software configuration, port connectivity and performance, as well as zoning. Sun 
StorageTek Business Analytics 5.0 provides three installation media for the supported 
server platforms: Windows Local Manager, Solaris Local Manager, and UNIX Agent 
Installation (HP-UX and AIX). 

To upgrade a Fabric Agent or multiple fabric agents, the procedure is to: 

1. Uninstall the previous version of the Fabric Agent. 

2. Install the current Fabric Agent. 

The decision to upgrade an existing Fabric Agent to that in the latest Sun StorageTek 
Business Analytics software may be performed because: 
 
• The Sun StorageTek Business Analytics Release Notes indicate a problem has been 

fixed or a new feature added. 
• The upgrade is recommended by your Sun representative. 

Automatic and Static Agent Registration 
Automatic agent registration is a configuration option for agent data collection. In the 
storability.ini file, automatic agent registration is configured as follows: 
 
• Local Manager – Specify the IP address or host name of the Local Manager to be 

contacted to activate agent registration.  
• Local Manager Registration Port – Specifies the TCP port number used by the 

Local Manager for agent auto registration. The default port number is 17146. 
• Enable Auto Registration – Turns agent auto registration on (default) or off. 
 
To register the Host Agent statically, proceed as follows: 
• Enter false in the Enable Auto Registration field.  
• Modify the Routing Agent static agent configuration to include an entry (port 

number|<agent IP address/name>)  
• Restart the Routing Agent 



Fabric Agent Installation Guide     Page 5 
  

Fabric Agent Objects 
Table 1 lists the objects that the unified fabric agent publishes. 
 
Table Columns 
gsa_alerts-3-0 sourceip, priority, alert_id, progname, alert, time, 

firsttime, refreshedtime, int1, text1, text2. 
gsa_agent_version-2-0 ip_address, agent_name, version, compile_time, 

managed_entities, tz_name, tz, timestamp 
gsa_cache_control-2_1 ip_address, port, table_name, cache_age, 

last_update_request_length, update_request_pending, 
group_name, group_master,timestamp 

gsa_ini_control-2_0 ip_address, port, domain, parameter, value, status, 
timestamp 

gsa_parm_info ip_address, port, object, parm_name, value_syntax, 
description, example 

gsa-fabric_ports_perf acom_id, ip_address, switch_wwn, port_wwn, 
report_interval_sec, sample_interval_sec, cnt_errors, 
rx_frames_per_sec, tx_frames_per_sec, 
tx_bytes_per_sec,, rx_bytes_per_sec, 
tx_peak_bytes_per_sec, rx_peak_bytes_per_sec, 
timestamp. 

gsa-fabric_switch-2_1 ip_address, switch_wwn, switch_name, 
mgt_ip_address, dev_ip_address, dev_ip_address2, 
model, role, state, timestamp 

gsa_fabric_ports-2_1 ip_address, domain, port, fabric_wwn, switch_wwn, 
port_wwn, port_state, port_type, att_port_id, 
att_node_wwn, timestamp 

gsa_fabric_zone ip_address, fabric_wwn, z_type, z_name, 
member_type, member_name, effective, timestamp. 

Table 1 –Fabric Agent Objects 

Fabric Agent Matrix 
 
Item Description 

Support Prerequisites . 
Software and Hardware Requirements Refer to the Sun StorageTek Business Analytics 

Support Matrix. 
Brocade Configuration Parameters Switch management IP Address or host name 

User name 
User password 
 

Use the switch management interface of the switch 
with the highest firmware revision indicated in the 
Sun StorageTek Business Analytics Support Matrix. 

SWAPI Configuration Parameters Switch management IP Address or host name 
SWITCH 
Port 
 User name 
User password 
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Item Description 

FA-MIB Configuration Parameters IP address or host name 
SNMP Read Community 
Port (default port is 161) 

Cisco  IP address or host name 
SNMPv2 Read Community 
Port Number (default port is 161) 
 

SNIA SMI (CIM) Provider Switch or Proxy IP address or host 
name 
Port (default port is 5988) 
Provider namespace 
User name 
User password 
 

Prerequisites Verification  
Verify Brocade User Name, Password, 
Switch Management IP Address 

telnet <switch_mgt_ip_adress> 
<user name> 
<password> 

SWAPI-supported Fabric (Refer to the 
Sun StorageTek Business Analytics 
Support Matrix) 

telnet <switch_mgt_ip_adress> 
<user name> 
<password> 

FA-MIB-supported Fabric (Refer to 
the Sun StorageTek Business 
Analytics Support Matrix) 

bulkall –ip <ip_address> -o 
<output_filename> 
 
a. Open the output file. 
b. Verify it is not empty. 
 
If it is empty, verify with the site administrator that 
SNMP is enabled on the device. 

Cisco IP and bulkall  bulkall –ip <ip_address> -i cisco-debug-
mib.txt –ver 1 -o <output_filename> 
 
Note: Cisco fabric switches support many SNMP 
MIBs that the Fabric Agent does not use. The 
StorageTek-supplied cisco-debug-mib.txt file limits 
verification to only MIBs that the agent uses. When 
you use bulkall with this file, you are only 
verifying the MIBs the Fabric Agent uses.  
 
The above example assumes the bulkAll utility and 
the cisco-debug-mib.txt file are located in the same 
folder/directory. 

Agent Installation  
Windows  • Windows Local Manager Installation CD 

(InstallShield) 
• Windows Administrator privileges 
 

Solaris  • Solaris Local Manager Installation CD (package 
installation) 

• root user privileges 
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Item Description 

Best Practices  

Maximum Number of Monitored 
fabrics/fabric switches (per agent)  

StorageTek has no finite limitation on the number of 
switches. However, if you are collecting from more 
than 300 ports, you may want to consider deploying 
another Fabric Agent. Minimally, increase the 
CONFIG_CACHE_REFRESH_INTERVAL and disable 
performance collection. 

SWAPI and Fabric Under Service 
Processor Management 

SWAPI is NOT supported for a fabric under Service 
Processor Management. 

Restrictions The Fabric Agent does not currently support using 
SSL (secure mode) in collection of the information.   

Configuration Parameters Note: Some configuration settings only apply to a 
specific fabric switch product interface. 

Local Manager IP address or host name of the Local Manager that 
will be contacted for agent auto registration. 

Local Manager Port The TCP port number the Local Manager uses for 
agent auto registration. The default port number is 
17146. 

Enable Auto Registration Turns agent auto registration on (default) or off. 

CONFIG_CACHE_REFRESH_INTERVAL Configuration cache refresh interval in seconds; 
default value is 1200 seconds. 

CMD_EXECUTION_TIMEOUT Time to wait in seconds for execution of each CLI 
command, If performance is disabled, StorageTek 
suggests you do not set this configuration variable. 
If performance is enabled, the default value of 
CMD_EXECUTION_TIMEOUT=0.9 of minimal 
PERF_SAMPLE_INTERVAL, 
CONFIG_CACHE_REFRESH_INTERVAL. 

PERF_REPORT_INTERVAL Interval at which performance data is expected to be 
collected (hourly). Default is 3600 seconds. 

PERF_SAMPLE_INTERVAL Optional parameter that specifies the interval in 
seconds to collect performance data. If not set or set 
to zero, performance data collection is disabled. 
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Item Description 

IP_INCLUDE This is an optional parameters with multiple entries 
allowed. If provided, this setting specifies which 
switches to include in reporting based on their IP 
address or subnet.   
 
The format used is the address/netmask convention 
that is commonly used in networking applications: 
 
IP_INCLUDE = address (where the address is 
specific hostname or IP address) 
 
Or: 
 
IP_INCLUDE = network/netmask (where the address 
belongs to specified network with specified netmask.  
 
Note: The separator is a forward slash “/”) 
 
The network is any valid IP address, and the 
netmask is an integer between 0 and 32 specifying 
the number of bits to use when comparing the 
numerical network. 
 
If no IP_INCLUDE parameter is specified, the default 
agent behavior is to include all switches.   

IP_EXCLUDE This is an optional parameters with multiple entries 
allowed. 
 
If provided, this setting specifies which switches to 
exclude from reporting based on their IP address or 
subnet with an optional integer netmask.   
 
The format is: 
 
IP_EXCLUDE = address  
or 
IP_EXCLUDE = address/netmask  
 
If provided, this parameter specifies which switches 
to exclude from reporting based on their IP address 
or subnet.  If not specified, the default behavior is 
not to exclude any switches. 
 
Note: If two Local Managers have Fabric Agents 
that can collect on the same fabric, Sun 
recommends that you use this configuration 
parameter to choose which Local Manager will collect 
data from that fabric. 
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Item Description 

SAVE_FABRIC_DATA_DIR This is an optional configuration setting and is 
disabled by default. If set, this should be the full 
pathname to a directory where intermediate API 
data files will be created.  The Fabric Agent will 
append intermediate API data to files that are 
named saved_*.txt in the specified directory for 
offline debugging. 

BRCD_CLI_PATH This is an optional configuration setting and is 
disabled by default.  When disabled, the agent looks 
for brcdCLI in the same directory as the agent 
binary.   
 
If set, it specifies the full pathname of an alternate 
brcdCLI executable, including the executable name 
(e.g. C:\testdir\brcdCLInew.exe).   

FAMIB_CLI_PATH This is an optional configuration setting and is 
disabled by default. If set, it specifies a non-
standard location of FAMIB CLI. 

SWAPI_CLI_PATH This is an optional configuration setting and is 
disabled by default. If set, it specifies a non-
standard location of SWAPI CLI. 

CISCO_CLI_PATH This is an optional configuration setting and is 
disabled by default. If set, it specifies a non-
standard location of the CISCO CLI. 

CIM_CLI_PATH  This is an optional configuration setting and is 
disabled by default. If set, it specifies a non-
standard location of the CIM_CLI_PATH. 

FAMIB_OFFLINE_DIR This is an optional configuration setting and is 
disabled by default. If set, it specifies a directory in 
which the agent will look for offline bulkAll output for 
debugging purposes. 

CISCOMIB_OFFLINE_DIR  This is an optional configuration setting and is 
disabled by default. If set, it specifies a directory in 
which the agent will look for offline bulkAll output for 
debugging purposes. 

BRCD_IP IP Address or host name, Brocade User Name, 
Brocade User Password. One entry is required per 
fabric; two entries are recommended for 
redundancy. StorageTek recommends you do not 
configure more than two entries. 
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Item Description 

SWAPI_IP This interface is specified by an IP Address or host 
name, switch/proxy, port user name, and password. 
One entry is required per switch supporting SWAPI; 
two or more entries are recommended for 
redundancy. 
Note: 
The Fabric Agent does not communicate with service 
processors implementing SWAPI in proxy mode. 

FAMIB_IP This interface is specified by IP address or host 
name, SNMP Read Community, and port specify this 
interface. The default port is 161. 

CISCO_IP CISCO_IP = ip|SNMPv2 Read community 
string|SNMP port. This product interface can be used 
for switches that support Cisco switches over 
SNMPv2 using the Cisco-specific MIBs. 
 
One entry is required per fabric containing a Cisco 
switch; two or more entries are recommended for 
redundancy.  The agent will automatically discover 
additional Cisco switches in the fabric. 
 
The Fabric Agent requires SNMPv2 to be enabled on 
each Cisco switch. The read community string is 
encrypted before it is written to storability.ini file.   
 
The Fabric Agent assumes the same read community 
string is valid for all switches discovered in the same 
fabric. Currently, the Fabric Agent does not support 
SNMPv3. 

CIM_IP CIM_IP = provider ip|provider port  
(5988)|namespace| username|password 
 
This product interface can be used for switches that 
support the CIM interface. One entry is required per 
SMI provider. This entry support one or several 
fabrics at the same time, depending on the 
configuration of the provider.  
The first field is the IP address of a CIM provider.  
This may be an individual switch that supports CIM 
natively, or a CIM proxy reporting on one or more 
switches. The second field is the CIM provider port, 
which is TCP port number 5988 by default. The third 
field, the namespace value, must be obtained from 
the vendor documentation for the CIM provider. 
 
The Username and password must be configured for 
an account that grants access to the CIM provider. 
 
 

Table 2 - Fabric Agent Matrix 
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Installing Fabric Agent - Windows 
The following section describes how to install and configure the Fabric Agent on a 
Windows platform.  

1. Insert the Sun StorageTek Business Analytics Windows Local Manager CD into the 
CD-ROM drive. 

2. Click Next on the Welcome menu to continue the installation. 

3. Click Yes to accept the terms of the software license agreement. 

4. Review/modify the User Name and Company Name and click Next>. 

5. Check the Fabric Agent checkbox on the screen that lists agents for installation. 

 

   Figure 1 - Agent Selection Dialog 
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6. Review the settings and click Next. 

7. Specify whether or not to install the new version of the Configuration Tool. 

8. When the Configuration Tool is automatically launched, select File -> Edit -> Smart 
Agent Configuration. 

9. Click the Fabric Agent tab and click Add. Use the list box to select the fabric 
product interface (e.g., BRCD_IP) you are configuring.  

 

Figure 2 - Fabric Agent Configuration Window 

Brocade 

User Name – Brocade user name for agent authentication 

Password – Brocade user’s password for agent authentication 

IP Address – Switch management IP address 

FA-MIB 

IP Address – IP address to access the SNMP MIB. 

Community –SNMP read string (default SNMP read community is public). 

Port – TCP port number (default port is 161). 

SWAPI 

IP Address –Switch management interface IP address 



Fabric Agent Installation Guide     Page 13 
  

User Name – User name used for agent authentication 

Password – User’s password 

CISCO IP 

IP Address – IP address to access the Cisco switch. 

SNMPv2 Read community string - SNMP read string (default SNMP read 
community is public). 

Port - TCP port number (default port is 161). 

CIM_IP 

Provider IP – Specify one entry per SMI provider. This entry support one or 
several fabrics at the same time, depending on the configuration of the provider. 

Provider Port – Specify the provider port number. The default port number is 
5988. 

Namespace – Specify the namespace value that must be obtained from the 
vendor documentation for the CIM provider. 

User Name – Specify a user name for an account that grants access to the CIM 
provider. 

Password – Specify a password for the above specified user. 

10. Click Submit after you have finished configuring the fabric product interfaces. 

11. For Local Manager, specify the IP address or host name of the Local Manager to be 
contacted for agent auto registration. 

12. For Local Manager Port, specify the TCP port number the Local Manager uses for 
agent auto registration. The default port number is 17146. 

13. Click Show Advanced Settings and review/modify the following configuration 
variables: 

• Enable Auto Registration – Turns agent auto registration on (default) or off. 
Default value is true (enabled) but may be set to false to disable agent auto 
registration. 

• Config. Cache Interval – Specifies the configuration cache refresh interval in 
seconds; default value is 1200. 

• Connect Timeout – Specifies the time to wait in seconds for execution of each 
CLI command, If not set, the fabric agent will wait ninety (90) percent of the 
Fabric Refresh Interval. 

• Performance Report Interval - Specifies the interval at which performance 
data is expected to be collected (hourly). Default is 3600 seconds. 

• Performance Sample Interval – Is an optional parameter that specifies the 
interval in seconds to collect performance data. If not set or set to zero, 
performance data collection is disabled. 
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• IPs to Include - This is an optional parameter with multiple entries allowed. If 
provided, this setting specifies which switches to include in reporting based on 
their IP address or subnet.   

The format used is the address/netmask convention that is commonly used in 
networking applications: 

IP_INCLUDE = address (where the address is specific hostname or IP address) 

Or: 

IP_INCLUDE = network/netmask (where the address belongs to specified 
network with specified netmask.   

Note: The separator is a forward slash (“/”). 

The network is any valid IP address, and the netmask is an integer between 0 
and 32 specifying the number of bits to use when comparing the numerical 
network. If no IP_INCLUDE parameter is specified, the default agent behavior is 
to include all switches.   

• IPs to Exclude - This is an optional parameter with multiple entries allowed. 
This option is disabled by default. 

If turned on, this setting specifies which switches to exclude from reporting based 
on their IP address or subnet with an optional integer netmask.   

The format is: 

IP_EXCLUDE = address  

Or: 

IP_EXCLUDE = address/netmask  

If provided, this parameter specifies which switches to exclude from reporting 
based on their IP address or subnet.  If not specified, the default behavior is not 
to exclude any switches. 

• BRCD_CLI_PATH - This is an optional configuration setting and is disabled by 
default.  When disabled, the agent looks for brcdCLI in the same directory as the 
agent binary.  If set, it specifies the full pathname of an alternate brcdCLI 
executable, including the executable name (e.g. C:\testdir\brcdCLInew.exe).   

• FAMIB_CLI_PATH - This is an optional configuration setting and is disabled by 
default. If set, it specifies a non-standard location of FAMIB CLI. 

• SWAPI_CLI_PATH - This is an optional configuration setting and is disabled by 
default. If set, it specifies a non-standard location of SWAPI CLI. 

• CISCO_CLI_PATH -  This is an optional configuration setting and is disabled by 
default. If set, it specifies a non-standard location of the CISCO CLI. 

• CIM_CLI_PATH - This is an optional configuration setting and is disabled by 
default. If set, it specifies a non-standard location of the CIM_CLI_PATH. 
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• CISCOMIB_OFFLINE_DIR - This is an optional configuration setting and is 
disabled by default. If set, it specifies a directory in which the agent will look for 
offline bulkAll output for debugging purposes. 

• FAMIB_OFFLINE_DIR - This is an optional configuration setting and is disabled 
by default. If set, it specifies a directory in which the agent will look for offline 
bulkAll output for debugging purposes. 

14. With “Save Configuration Settings” turned on (check mark), select File->Save and 
confirm saving changes to the storability.ini file. 

15. Select File-> Exit to close the Configuration Tool. 

16. Use the Windows Services panel to start the Storability Fabric Agent before you 
verify agent functionality.  

Important Note: 

The Fabric Agent will not start if any switch is misconfigured in the storability.ini file. 
That is, the Fabric Agent will not start even though other switches in the storability.ini 
file are properly configured. In this case, refer to the Troubleshooting section of this 
guide to troubleshoot any misconfigured switches, fix the incorrect configuration 
parameters, and resave the configuration settings. You may then restart the Fabric 
Agent. 

 

Installing the Fabric Agent – Solaris 
The following section describes the installation procedure for installing the Fabric Agent 
for Brocade, SWAPI, Cisco, or FA-MIB. For the installation procedure for SNIA SMI 
(CIM), refer to the following Installing the Fabric Agent and GSMcimfab on Solaris 
section. 
 

1. Mount the installation CD on the Solaris server. For example: 

mount –F hsfs –o ro /dev/dsk/c0t6d0s0 /mnt 

2. Change directory to the UNIX directory for the Solaris operating system (e.g., 
Solaris/8). 

3. Run the pkgadd command. The main package installation menu for Storability agents 
is displayed. 

 pkgadd –d . 
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Figure 3 - Fabric Agent Package Selection 
 

4. Type the package selection number for the Fabric Agent; type 10 and press Enter to 
select installing the Fabric Agent. 

5. Read the information on the types of switches that the Fabric Agent supports 
collecting data. 

6. Specify whether (y/n) the Fabric Agent will monitor Brocade switches.  

 

Figure 4 - Brocade Switch Configuration Settings 
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7. If you specify data will be collected from Brocade switches, enter: 

• IP Address – Switch management IP address.  

• User Name – Brocade user name for agent authentication 

• Password – Brocade user’s password for agent authentication 

8. Press Enter on a blank IP Address line to indicate you have completed entering 
configuration parameters for Brocade switches and to continue. 

9. Specify whether (y/n) the Fabric Agent will collect data from Cisco switches. 

10. If you specified the agent will collect data from Cisco switches, enter: 

• IP Address – IP address to access the Cisco switch. 

• SNMPv2 Read community string - SNMP read string (default SNMP read 
community is public). 

• Port - TCP port number (default port is 161). 

11. Press Enter on a blank IP Address line to indicate you have completed entering 
configuration parameters for Cisco switches and to continue. 

12. Specify whether (y/n) the Fabric Agent will collect data from FA-MIB fabric product 
interfaces (e.g., McData). 

13. If you specified the agent will collect data from FA-MIB switches like McData, enter: 

IP Address – IP address to access the SNMP MIB. 

Community –SNMP read string (default SNMP read community is public). 

Port – TCP port number (default port is 161). 

14. Press Enter on a blank line IP address line to indicate you have completed 
configuring McData (FA-MIB) switches. 

15. Specify whether (y/n) the Fabric Agent will collect data from SWAPI fabric product 
interfaces (e.g., McData). 

16. If you specified the agent will collect data from SWAPI fabric product interface (e.g., 
McData), enter: 

• IP Address –Switch management interface IP address 

• User Name – User name used for agent authentication 

• Password – User’s password 

17. Press Enter on a blank IP address line to indicate you have completed configuring 
SWAPI (.e.g. McData) switches. 

18. Specify whether (y/n) the Fabric Agent will collect performance data. By default, the 
Fabric Agent does not collect performance data. 
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Note: Collecting performance data may take a considerable amount of time and 
agent resources. 

19. Type y and press Enter to review/modify the Advanced Settings. 

 

Figure 5 - Fabric Agent Advanced Settings 

 

• Specify whether (y/n) to have the Fabric Agent restarted by the Agent Monitor if 
the agent is detected as not running. 

• Specify the frequency that the Fabric Agent will collect data. The default interval 
is 1200 seconds. 

• Specify the frequency that the Fabric Agent will collect performance data. The 
default interval is 3600 seconds. 

• Specify how long the Fabric Agent will wait for a command to be executed. The 
default timeout is 900 seconds. 

• Specify whether (y/n) to enable offline data collection for debugging purposes. 
The default value is offline data collection is disabled. 

• Specify whether (y/n) to enable explicit switch IP whitelists. This is an optional 
parameter with multiple entries allowed. This option is disabled by default. 

If turned on, this setting specifies which switches to include in reporting based on 
their IP address or subnet.   

The format used is the address/netmask convention that is commonly used in 
networking applications: 

IP_INCLUDE = address (where the address is specific hostname or IP address) 
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Or: 

IP_INCLUDE = network/netmask (where the address belongs to specified 
network with specified netmask.   

Note: The separator is a forward slash (“/”). 

The network is any valid IP address, and the netmask is an integer between 0 and 
32 specifying the number of bits to use when comparing the numerical network. If 
no IP_INCLUDE parameter is specified, the default agent behavior is to include all 
switches.   

• Specify whether (y/n) to enable explicit switch blacklists. The option is disabled by 
default.  

If turned on, this setting specifies which switches to exclude from reporting based 
on their IP address or subnet with an optional integer netmask.  The format is: 

IP_EXCLUDE = address  

Or: 

IP_EXCLUDE = address/netmask  

If provided, this parameter specifies which switches to exclude from reporting 
based on their IP address or subnet.  If not specified, the default behavior is not to 
exclude any switches. 

• Specify whether (y/n) agent auto registration is turned on (default) or turned off. 

• Specify the IP address or network resolvable host name of the Local Manager that 
will be contacted for agent auto registration. The default value is local host. 

• Specify the TCP port number the Local Manager uses for agent auto registration. 
The default port number is 17146. 

20. Specify (y/n) whether to continue with the installation of the Fabric Agent. 

21. Specify (y/n) whether to restart the agents after the installation has completed.  

Important Note: 

The Fabric Agent will not start if any switch is misconfigured in the storability.ini file. 
That is, the Fabric Agent will not start even though other switches in the storability.ini 
file are properly configured. In this case, refer to the Troubleshooting section of this 
guide to troubleshoot any misconfigured switches, fix the incorrect configuration 
parameters, and resave the configuration settings. You may then restart the Fabric 
Agent. 

22. The installation proceeds and returns you to the main package installation menu. 

23. Press Ctrl-D and q to exit to the command line. 

Installing the Fabric Agent and cimfab – Solaris 
The following section describes the installation procedure for installing the Fabric Agent 
and then the CIM package on Solaris 9. 
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1. Mount the installation CD on the Solaris server. For example: 

mount –F hsfs –o ro /dev/dsk/c0t6d0s0 /mnt 

2. Change directory to the UNIX directory for the Solaris 9 operating system. 

3. Run the pkgadd command.  

 pkgadd –d . GSMfabric GSMcimfab 

4. Read the information on supported vendors and product interfaces. Note: The 
installation instructions for all other supported products and product interfaces are 
provided in the previous instruction. This section assumes you are installing the CIM-
enabled interface (CIMfab). 

 

Figure 6 - Package Install Menu for GSMfabric and GSMcimfab 

 

5. Specify whether (y/n) data will be collected from Brocade switches. 

6. Specify whether (y/n) data will be collected from Cisco switches. 

7. Specify whether (y/n) data will be collected from McData (or other FA-MIB) switches 
using SNMP. 

8. Specify whether (y/n) data will be collected from McData switches using SWAPI. 

9. At the “Do you intend to install GSMcimfab?” prompt, type y and press Enter. 
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Figure 7 - Preparing To Install GSMcimfab 

10. Specify whether (y/n) to enable the collection of fabric performance data. 

11. Type y and press Enter to review/modify the Advanced Settings. 

12. Specify whether (y/n) to have the Agent Monitor automatically restart the agent if 
it is detected as not running. 

13. Specify the frequency the configuration cache is refreshed. The default value is 
1200 seconds. If not set or set to zero, performance data collection is disabled. 

14. Specify the frequency the agent collects fabric performance data. The default value 
is 1200 seconds. 

15. Specify the interval for performance data to be collected hourly. The default value 
is 3600 seconds. 
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16. Specify the time to wait in seconds for execution of each CLI command.  

Figure 8 - Specify Fabric Agent Advanced Settings 

17. Specify whether (y/n) to enable explicit switch IP whitelists. This is an optional 
parameter with multiple entries allowed. This option is disabled by default. 

18. If turned on, this setting specifies which switches to include in reporting based on 
their IP address or subnet.  The format used is the address/netmask convention 
that is commonly used in networking applications: 

IP_INCLUDE = address (where the address is specific hostname or IP address) 

Or: 

IP_INCLUDE = network/netmask (where the address belongs to specified network 
with specified netmask.   

Note: The separator is a forward slash (“/”). 

The network is any valid IP address, and the netmask is an integer between 0 and 
32 specifying the number of bits to use when comparing the numerical network. If 
no IP_INCLUDE parameter is specified, the default agent behavior is to include all 
switches.   

19. Specify whether (y/n) to enable explicit switch blacklists. The option is disabled by 
default. If turned on, this setting specifies which switches to exclude from reporting 
based on their IP address or subnet with an optional integer netmask.  The format 
is: 

IP_EXCLUDE = address  

Or: 

IP_EXCLUDE = address/netmask  

20. If provided, this parameter specifies which switches to exclude from reporting 
based on their IP address or subnet.  If not specified, the default behavior is not to 
exclude any switches. 
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21. Specify whether (y/n) agent auto registration is turned on (default) or turned off. 

22. Specify the IP address or network resolvable host name of the Local Manager that 
will be contacted for agent auto registration. The default value is local host. 

23. Specify the TCP port number the Local Manager uses for agent auto registration. 
The default port number is 17146. 

24. Specify whether (y/n) to restart the agents after installation. 

25. Specify whether (y/n) to continue with the installation of the Fabric Agent package. 

26. If you specify to continue the installation, the installation proceeds and displays a 
successful installation message when it has completed.  

 

 

Figure 9 - Fabric Agent Installation Completed 

27. Read the information on how to configure CIM topology configuration and how to 
specify that you have finished configuring CIM-enabled switches. 

28. Enter the provider switch or proxy IP address or host name and press Enter. 
29. Enter the user name and press Enter. 
30. Enter the password for this user and press Enter. 
31. Confirm the password. 
32. Specify the port number or simply press Enter to accept the default port of 80. 
33. Specify the provider namespace and press ENTER. 
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Figure 10 - Specify SNIA SMI (CIM) Configuration Settings 

 
34. Specify whether (y/n) to enable fabric performance data collection. 
35. Type y and press Enter to review/modify the Advanced Settings. 
36. Specify whether (y/n) to have the Agent Monitor restart the agent if it is detected 

as not running. 
37. Specify the frequency for the configuration cache to be refreshed. The default value 

is 1200 seconds. 
38. Specify optionally the interval in seconds to collect performance data. The default 

value is 1200 seconds. If set to zero or not set, performance data collection is 
disabled. 

 
 

 

Figure 11 - GSMcimfab Advanced Settings 
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39. Specify the interval for performance data to be collected hourly. The default value 
is 3600 seconds. 

40. Specify the time to wait in seconds for execution of each CLI command.  
41. Specify whether (y/n) to enable explicit switch IP whitelists. This is an optional 

parameter with multiple entries allowed. This option is disabled by default. 
42. If turned on, this setting specifies which switches to include in reporting based on 

their IP address or subnet.  The format used is the address/netmask convention 
that is commonly used in networking applications: 
 
IP_INCLUDE = address (where the address is specific hostname or IP address) 
Or: 
IP_INCLUDE = network/netmask (where the address belongs to specified network 
with specified netmask.   
 
Note: The separator is a forward slash (“/”). 
 
The network is any valid IP address, and the netmask is an integer between 0 and 
32 specifying the number of bits to use when comparing the numerical network. If 
no IP_INCLUDE parameter is specified, the default agent behavior is to include all 
switches.   

43. Specify whether (y/n) to enable explicit switch blacklists. The option is disabled by 
default. If turned on, this setting specifies which switches to exclude from reporting 
based on their IP address or subnet with an optional integer netmask.  The format 
is: 
 
IP_EXCLUDE = address  
Or: 
IP_EXCLUDE = address/netmask  

  
If provided, this parameter specifies which switches to exclude from reporting 
based on their IP address or subnet.  If not specified, the default behavior is not to 
exclude any switches. 

44. Specify whether (y/n) agent auto registration is turned on (default) or turned off. 
45. Specify the IP address or network resolvable host name of the Local Manager that 

will be contacted for agent auto registration. The default value is local host. 
46. Specify the TCP port number the Local Manager uses for agent auto registration. 

The default port number is 17146. 
47. Specify whether (y/n) to restart the agents after installation. 
48. Specify whether (y/n) to continue with the installation of the GSMcimfab package. 
 
 

 

Figure 12 - Completing GSMcimfab Installation 

 
49. The package installation completes and returns you to the command line. 
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Verifying the Fabric Agent 
This section describes how to use GSMdiag to verify the Fabric Agent. If the collected 
objects are not complete, proceed to the Fabric Agent Troubleshooting section. 
   

1. Use the GSMDiag utility to verify agent functionality. 

a. Enter the IP Address or Hostname of the server where the agent is installed, 
and select the Storability Fabric Agent from the drop down list of service 
names. 

b. Click the Get Object List button and you should receive a list of objects 
published by the Fabric Agent. 

c.   Select the gsa_fabric_switch object published by the agent. Verify the correct 
number of switches is reported. 

 

Figure 13 - GSMdiag: gsa_fabric_switch-2_1 Object 

 

d. Verify all other objects published by the agent. 

2. To verify the Fabric Agent has registered successfully with its configured Local 
Manager: 

a. In the Agent location window, enter the IP Address or network resolvable 
Host Name of the Local Manager in the ip address/host name input box. 

b. Set the port to 17146 (or select the Storability Routing Agent from the drop 
down list of service names).  

c.   Click the Get Object List button and you should receive a list of tables 
published by the Routing Agent. 

d. Select the gsa_agent_register object. 

e. Verify this collected object reports the Storability Fabric Agent in the 
“active_peer” field by IP address and port number. 
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Verifying Management Console Functionality 
The following procedure describes how the Sun StorageTek Business Analytics 
administrator verifies the Fabric Agent’s reports in the Management Console. Refer to 
the Administration chapter to obtain information on the administrative menus you can 
access from the Tools pull down menu, including the Polling and Change Dashboard 
menus. 
 
1. Log in to the Management Console as an administrative user (e.g., gsmuser) whose 

views provide access to the desired assets (e.g., sites). 
2. Verify that your customized Home Page includes the Fabric Utilization Overview 

dashboard (or use Change Dashboard to assign one). 
3. Select Tools->Data Polling Schedule. 
4. Use the Collect Now button to collect the Fabric (collection type) Configuration 

(Collection Metric) data using a polling schedule that includes the specific site or all 
sites. 

5. Use the Collect Now button to collect the Fabric (collection type) Performance 
(Collection Metric) data using a polling schedule that includes the specific site or all 
sites. 

6. Close the Data Polling Schedule window. 
7. Verify the Fabric Utilization Overview dashboard reports information on the 

fabrics monitored by the Fabric Agent you are verifying.  
 

 

Figure 14 - Fabric Utilization Overview 

 
8. Close the browser session with the Management Console as the above steps 

complete verifying the Management Console functionality. 

Fabric Agent Troubleshooting 
 

1. Verify system/agent prerequisites – Refer to Sun StorageTek Business Analytics 
Support Matrix that is located on the Documentation CD to verify the most recent 
support requirements for the agent. 

2. Review the Message Log – Review/collect the Message.log file that can contain 
information on startup errors, configuration errors, or errors regarding accessing 
data or parsing output.  

 
Windows 

 
• Located by default in: <drive>:\Program Files\Storability\GSM\Agents\Storability 

Fabric Agent folder. 
• Can enable debug level logging by appending LOG_SEVERITY=Debug to the 

Fabric Agent section of the storability.ini file (if Storability Support requests it). 
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Solaris 
 

• Agents’ common Message.log file located by default in: /opt/storability/data. 
• Can enable debug level logging by appending LOG_SEVERITY=Debug to the 

Fabric Agent section of the storability.ini file (if Sun Support requests it). 
 
Message Types 
 

o No Information Received – Verify message is logged that the agent started. In 
addition, look for message that agent stopped.  

o Configuration Errors – Look for errors like “cannot create ini instance” or “ini 
file, storability.ini, is not valid. In this case, go the agent installation 
directory/folder and verify the storability.ini file is there. If not, re-install the 
agent.  

o Vendor-Specific -  “Wrong number of tokens for IP” or cannot extract valid IP 
address from ..”; indicate some type of configuration error. Will cause the 
agent to stop in most cases.  To resolve, delete and redefine the IP-related 
configuration parameters and then restart the agent. 

o Cannot set CacheUpdateInterval – No collection – Indicates the Config. Cache 
Interval setting in the storability.ini is not set with a valid parameter. 

o “Cannot get install of some object type” or “some object type is NULL” 
messages – Most likely indicates there is insufficient memory available on the 
agent machine. 

o “Cannot start CLI: cliName” - Check that the corresponding CLI is located in 
the installed directory. 

o “Timeout: Cannot start CLI: <cliName> during <number> sec. …… “ – Check 
the number and if it is less than one hundred (100), increase the 
CONFIG_CACHE_INTERVAL or the PERF_SAMPLE_INTERVAL in the 
storability.ini file. In the unlikely situation the problem cannot be resolved, 
send the Message log, storability.ini file, and GSMdiag file to Customer 
Support. 

o “Timeout:<Number> was not enough to read the info …” – Increase 
CONFIG_CACHE_INTERVAL or the PERF_SAMPLE_INTERVAL in the 
storability.ini file.  

o “Error writing ….” – Most likely there is not the necessary shared library 
installed. Check that the required shared libraries exist. 

o “Cannot connect …..”  or “cannot get some type of info” – Means usually there 
is an incorrect IP address or user credentials defined in the storability.ini file. 
If message “cannot connect”  for a specific vendor persists, use the tools 
described in Table 1 – Fabric Agent Matrix (e.g., bulkAll) to further 
troubleshoot the problem.  

o Look for messages that specifically describe how to troubleshoot a problem 
with a particular vendor CLI. 

o As a final troubleshooting action, you can run cliname 7 “<exact configuration 
setting in the storability.ini file for the IP address you are troubleshooting. Ou 
replace any host name with the IP address and use the decrypted password 
(if any). The file may contain more information in the error section than in the 
log and verifies the configuration information. Customer Support may request 
you send this resulting file with other requested information. 

 
For example 

 
brcdCLI 7 “10.1.1.27|username|password” > <filename>  

  
3. Use GSMdiag to save the output for all the tables if escalating a problem to Sun 

Technical Support. 
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a. Run GSMdiag. 
b. Enter the IP Address or Hostname of the server where the agent is installed 

and set the port number by selecting the Fabric Agent from the drop down list of 
service names. 

c. Click the Get Object List button and you should receive a list of tables published 
by the agent. If unsuccessful, verify the Ethernet connectivity to the server 
running the agent and that the Array Agent is running. 

d. Select the alerts-3_1 table and examine the Description column for each 
reported alert. 

e. Select File->Save All and the “This action will network fetch all objects 
published by the currently specified agent and save the data to a single file.” 
Message appears.  

f. Click OK and the Save As dialog appears.  
g. Enter a meaningful file name and click OK to initiate the collection. 
h. Enter the desired file name and click OK.  

 
4. Verify Local Manager Registration - The configured Routing Agent’s 

gsa_agent_register table should be reviewed if the auto-registration feature is 
enabled (default). Otherwise, verify the necessary sub agent entry has been added 
to the Routing Agent’s storability.ini file. 

5. Review the Routing Agent Message Log – Review/collect the Routing Agent 
Message Log to check for errors related to Ethernet connectivity problems contacting 
that Array Agent. 

6. Confirm Polling Schedules – Using the Management Console’s Polling menu, 
review/modify the existing Polling Schedules for the Collection Type of Fabric  for the 
specific site (or all sites).  

7. Review Aggregator Message Log – Open the Aggregator’s Message Log in a text 
editor and validate that the Fabric Tables are being requested and that rows are 
being inserted into the database. 

 
The log contains two entries, TID (Transaction ID) and SID (Session ID), which can 
help you locate (e.g., Find) and view relevant logged entries. For scheduled polling 
requests, the TID will be equal to the Job ID in the Polling menu. Each SID is a 
unique identifier for a particular agent data collection session. For on-demand polling 
requests, the TID is a uniquely generated TID (not the Job ID) and SID, and the TID 
and SID will be equal to the same integer value.  

 
8. Check the assurent database – The assurent database is the data repository for 

your Sun StorageTek Business Analytics application. For the Fabric Agent, use any 
MS SQL Query interface, such as osql, to verify rows have been inserted into the 
fabric-related tables, such as the gsa_fabric_switch-2_1 table. 

9. Verify Management Console Functionality – As a final step in the agent 
troubleshooting procedure, minimally verify the monitored fabric switches now 
appear in the Fabric Utilization Overview pane or in the Asset Management report for 
the site. 
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Upgrade Fabric Agents  
To upgrade a Fabric Agent (or multiple fabric agents), the procedure is to: 

1. Uninstall the previously installed Fabric Agent. 

2. Install the current Fabric Agent that Sun StorageTek Business Analytics provides. 

Upgrade Fabric Agent – InstallShield 
The procedure to upgrade the Fabric Agent on a Windows server is described as follows: 
 
1. Copy the existing storability.ini file with the multiple Fabric agents’ or unified Fabric 

Agent’s configuration settings to a “Backup” directory. 
2. Select Start->Program Files->Storability->Uninstall->Uninstall Local 

Manager. 
3. The Storability Uninstall dialog appears. 
4. Click the checkbox for the Fabric Agent, McData Agent, and/or Brocade Agent, as 

applicable for your installed fabric agents. Keep in mind you must uninstall any 
previously installed Fabric Agent before you upgrade to the current Fabric Agent. 

5. Click Next>. The Question dialog appears. 
6. Click Yes to confirm the uninstalling the agent. An uninstalling agent splash box 

appears as each selected agent is uninstalled. 
7. When the InstallShield Wizard Complete dialog box appears, click Finish. 
8. Install the current Fabric Agent that Sun StorageTek Business Analytics provides. 

Upgrade Fabric Agent – Solaris 
The procedure to uninstall the Fabric Agent(s) on a Solaris server is described below. As 
previously described, uninstall any previously installed Fabric Agent before you install 
the current Fabric Agent. 
 

1. Copy the <install_directory>/storability/etc/storability.ini file to a “Backup” 
directory. 

2. Type: 

    pkgrm GSMmcdata   OR: 

   pkgrm GSMbrocade   OR: 

   pkgrm GSMfabric  

as appropriate for your installed fabric agents. 

3. At the “do you want to remove this package” prompt, enter y and press Enter. 

4. At the “do you want to continue the removal of the package?” prompt, type y and 
press Enter. The “Removal of GSM <agent name> was successful” message 
appears. 




